
No.EX##-OMY0032-G 

 

 
 

 
 
 

 
 

PRODUCT NAME 
 

IO-Link Device Tool 
 

MODEL / Series / Product Number 
 

IO-Link Device Tool V5.1 PE 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
  



-1- 

 
No.EX##-OMY0032-G 

Contents 
 

1. Outline 2 

2. System Requirements and How to Obtain the Software 3 

3. Connection between an EX series and a PC 4 

4. Software Installation 5 

5. Starting the Software 8 

6. Importing an IOLM File 9 

7. Importing an IODD File 11 

8. How to Use the Software 13 

8.1. The IO-Link Module setting screen 13 

8.1.1. Search Master 13 

8.1.2. Individual selection 14 

8.2. IO-Link Module Setting Screen 15 

8.3. Common Screen 15 

8.4. Port Config Screen 16 

8.4.1. Reading the IO-Link Port Setting 16 

8.4.2. Changing the Settings of the IO-Link Ports (Only possible when not connected to PLC) 17 

8.4.3. Scanning IO-Link Devices 18 

8.4.4. IO-Link Device Validation Function / Data Storage Function Setting  

(Only possible when not connected to PLC) 19 

8.4.5. Port Config Details 20 

8.5. Setting Screen 21 

8.5.1. Reading IO-Link Module Parameters 21 

8.5.2. Setting the IO-Link Module Parameters (Only possible when not connected to PLC) 22 

8.6. Setting the IO-Link Devices 23 

8.6.1. Reading Information on IO-Link Devices 23 

8.6.2. IO-Link Device Process Data (Example using the ISE20B-L) 24 

8.6.3. IO-Link Device Identification (Example using the ISE20B-L) 24 

8.6.4. IO-Link Device Observation (Example using the ISE20B-L) 25 

8.6.5. IO-Link Device Parameter (Example using the ISE20B-L) 26 

8.6.6. IO-Link Device Diagnosis (Example using the ISE20B-L) 27 

8.6.7. IO-Link Device Scope (Example using the ISE20B-L) 27 

8.6.8. IO-Link Device Generic (Example using the ISE20B-L) 28 

8.6.9. IO-Link Device IODD (Example using the ISE20B-L) 29 

 
 

  



-2- 

 
No.EX##-OMY0032-G 

1.Outline 
 

The IO-Link Device Tool is an application software for IO-Link developed by Technologie Management 
Gruppe (TMG hereafter) in Germany, that makes the following operations possible for the IO-Link Module  
in the EX600, EX245 and EXW1 series. 
 

- Monitoring various parameters of IO-Link Module 
- Monitoring and setting various parameters of IO-Link devices 

 
Note: Applicable SI units, Fieldbus modules (FB module hereafter), compact wireless base and IO-Link 

Modules are as following. 
SI unit 
FB module 
Compact wireless base 

IO-Link Module 

EX600-SPN3/SPN4/SPN31 

EX600-LAB1, EX600-LBB1 

EX600-SEN7/SEN8 
EX600-SEC3/SEC4 
EX600-SEN3-X80 
EX600-MPN1 
EX600-MEN1 
EX600-MEC1 
EX600-BPN1 

EX600-LAB1-A, EX600-LBB1-A EX600-BEN1 
EX600-BEC1 
EX245-SPN1A/SPN2A/SPN3A EX245-LA1, EX245-LB1 
EXW1-BECAC/BPNAC1/BENAC1 
/BMTAC EXW1-RLAPA8C, EXW1-RLBPA7C 

 
 

  

IO-Link Device Tool 

IO-Link setting tool software 
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2.System Requirements and How to Obtain the Software 
 

■ How to Obtain the Software 
 

- IO-Link Device Tool 
 The IO-Link Device Tool can be downloaded from the following URL after registering your user information 
for a 30 days trial version. 

・URL：https://www.tmgte.de/en/products/io-link/io-link-device-tool-professional-edition.html 
 
- IOLM file 
 IOLM file can be downloaded from the website below. 
・URL：https://www.smcworld.com/en-jp/ 
  Product Information >> Operation Manuals >> Fieldbus System Serial Transmission System  

>> IO-Link Device Tool 
 
 

■ License Key 
 

- The IO-Link Device Tool can be used free of charge for 30 days after the first installation, but a license 
key is required after that period. A license key can be obtained in one of two ways: 

 
1) Purchase one from TMG. Either CmActLicense (limited to a single PC) or a USB dongle (valid when  

connected to any PC) 
=> Contact TMG for details. 

 
2) Purchase a USB dongle from SMC.  

Model No. EX9-ZSW-LDT1 
 
 
■ Resource Requirements 
 

Components Requirements 
Operating system Windows10 (64 Bit) 

Microsoft .Net Framework 4.6.1 
Free interfaces USB 1.1, 2.0 or 3.0 interface 

Ethernet network interface 
Screen resolution 1024 x 768 pixels or higher 

 
 
  

IO-Link Module 

IODD filer 

IO-Link device 

Communication cable 

https://www.tmgte.de/en/products/io-link/io-link-device-tool-professional-edition.html
https://www.smcworld.com/en-jp/
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3.Connection between an EX series and a PC 
 

■ Connect the EX600, EX245 and EXW1 series to a PC via a switching hub. 

 

 
Fig. Example of a connection using a switching hub and EX600 

 
 

■ If the IP address can be set without PLC, it is possible to connect directly to either the communication 
connectors on the SI unit or FB module using EX9-AC###EN-PSRJ. 

 
- Cable model No. 

EX9-AC020EN  -PSRJ 
     
  Cable length (L) 
  010 1m 
  020 2m 
  030 3m 
  050 5m 
  100 10m 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. Example of a direct connection between a PC and SI unit(EX600) 
  

Communication 
connector 

M12 RJ45 

Metal part Metal part 

Switching hub 
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4.Software Installation 
 

■ Install the software according to the following procedure: 
 

- If an old version of IO-Link Device Tool has been installed on the PC, be sure to uninstall it before 
installing the new version of IO-Link Device Tool. 

 
- Double-click Setup.exe. The following screen will appear. 

Select a language and then press [OK]. 
 
 
 
 
 
 
 
 
 
 
 

- Check the license terms, and if you agree, check "I accept the agreement" and then press [Next]. 
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- Select a folder to install the software and then press [Next]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- If you want to add a shortcut, check "Create a desktop shortcut" and then press [Next]. 
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- Check the installation conditions and if everything looks correct, press [Install]. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- The above screen appears when the installation is successful. Then press [Finish]. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The following description uses the manifold configuration example shown in Fig. 1. 

 
 
 
 
 
 
 
 
  

Fig. 1 EX600 manifold configuration example 

PC’s IP address: 192.168.0.250 EX600’s IP address: 192.168.0.1 

L#B 
 

IO-Link 
Module  

 
Slot2 

SPN# 
 

SI 
Unit 

 
Slot3 

 
 
 

Valve 

L#B 
 

IO-Link 
Module 

 
Slot1 

 
 
 

End plate 
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5.Starting the Software 
 

- When the IO-Link Device Tool V#.# is started, the following screen appears. 
- Select the Help > User Manual, to refer to the User Manual prepared by TMG (read the manual for a 
detailed description of the operations). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- Select a user role depending on the user authorization. 
User roles Password setting Initial password 
Specialist Allowed special 
Maintenance Not allowed maintain 
Observer Not allowed None 

      * For details of the user roles, refer to the User Manual prepared by TMG. 
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6.Importing an IOLM File 
 

■ To use the IO-Link Module in the EX600, EX245 and EXW1 series for IO-Link Device Tool, a dedicated 
setting file (IOLM file) must be imported. 
 

SI unit 
FB module 
Compact wireless base 

IOLM file 

EX600-SPN3/SPN4 SMC-EX600-SPN-LxB1-202*****-IOLM1.5.zip 
EX600-SPN31 SMC-EX600-SPN31-LxB1-202*****-IOLM1.5.zip 
EX600-SEN7/SEN8 SMC-EX600-SEN7_8-LxB1-202*****-IOLM1.5.zip 
EX600-SEC3/SEC4 SMC-EX600-SEC3_4-LxB1-202*****-IOLM1.5.zip 
EX600-SEN3-X80 SMC-EX600-SEN-LxB1-202*****-IOLM1.5.zip 
EX600-MPN1 SMC-EX600-MPN-LxB1-202*****-IOLM1.5.zip 
EX600-MEN1 SMC-EX600-MEN-LxB1-202*****-IOLM1.5.zip 
EX600-MEC1 SMC-EX600-MEC-LxB1-202*****-IOLM1.5.zip 
EX600-BEN1 SMC-EX600-BEN-LxB1-202*****-IOLM1.5.zip 
EX600-BPN1 SMC-EX600-BPN-LxB1-202*****-IOLM1.5.zip 
EX600-BEC1 SMC-EX600-BEC-LxB1-202*****-IOLM1.5.zip 
EX245-SPN1A SMC-EX245-SPN_FX-Lx1-202*****-IOLM1.5.zip 
EX245-SPN2A/SPN3A SMC-EX245-SPN_Cu-Lx1-202*****-IOLM1.5.zip 
EXW1-BECAC SMC-EXW1-BEC-202*****-IOLM1.5.zip 
EXW1-BPNAC1 SMC-EXW1-BPN-202*****-IOLM1.5.zip 
EXW1-BENAC1 SMC-EXW1-BEN-202*****-IOLM1.5.zip 
EXW1-BMTAC SMC-EXW1-BMT-202*****-IOLM1.5.zip 

 
- The following shows how to import an IOLM file. 

 
(1) Select File > Import IOLM (IO-Link Module Description). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

(1) 
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(2) Select a folder where the IOLM file in zip format is saved. 
(3) Press [OK]. 
(4) Check the IOLM file to be imported. 
(5) Press [Import]. 
(6) “SMC Corporation” is added to the Module folder in the Catalog. 
 
 
 
 
 
 
 
 

  

(2) 

(4) 

(3) (5) 

(6) 
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7.Importing an IODD File 
 

■ To set an IO-Link Device by using IO-Link Device Tool, an IODD file for each device must be imported. 
 

- For how to obtain an IODD file, contact the manufacturer of your device. 
- How to import the IODD file of the SMC EX260-SIL1 is shown below. 

The IODD file can be downloaded from the URL below. 
URL: https://www.smcworld.com/en-jp/ 
Product Information >> Operation Manuals >> Fieldbus System Serial Transmission System >> IO-
Link Device>> EX260-SIL1 >> Configuration File 

 
 

(1) Select the File > Import IODD (IO Device Description). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

(1) 

https://www.smcworld.com/en-jp/


-12- 

 
No.EX##-OMY0032-G 

 
 
(2) Select the folder where the IODD file is saved. 
(3) Press [OK]. 
(4) Check the IODD file to be imported. 
(5) Press [Import]. 
(6) EX260-SIL is added to the IO-Link folder in the Catalog. 
 
 
 
 
 
 
 

  

(2) 

(4) 

(3) 
(5) 

(6) 
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8.How to Use the Software 
 
8.1. The IO-Link Module setting screen  
8.1.1. Search Master 
 - After connecting the SI unit, FB module or compact wireless base to a PC, supply power to the EX600 or 
EXW1 and conduct the operation as follows. 
  
 Note: EX245 does not support the function of Search Master. 
 
(1) Press [Search Master]. 
(2) When the scanned EX600 or EXW1 is shown on the Master Discovery screen, double-click it. 

The IO-Link Module setting screen will appear. 
  
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

(1) 

(2) 

* If the EX600 or EXW1 does not appear, perform the following. 
- Make sure an IP address has been set for the SI unit, FB module or compact 
 wireless base. 
- Turn off the EX600 or EXW1 and then turn it on again. 
- Restart the IO-Link Device Tool. 
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8.1.2. Individual selection 
- After connecting the SI unit, FB module or compact wireless base to a PC, supply power to the EX600, 
EX245 or EXW1 and conduct the operation as follows. 

 
(1) Select the IOLM file that matches the SI unit, FB module or compact wireless base to be used. 
(2) Drag and move to Topology. The IO-Link Module setting screen will appear. 
(3) Press [Enter IP address] to display the input screen. 
(4) Input the IP address of the using SI unit, FB module or compact wireless base. 
(5) Press [OK]. 
 
 
 

 
  

(1) 

(2) 

(5) 

(4) 

(3) 
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8.2. IO-Link Module Setting Screen 

 - The IO-Link Module Setting Screen has the three tabs shown below. Selecting a tab changes the 
screen. 
№ Tab name Outline 
1 Common Shows specific information such as the vendor ID of the EX600/EX245/EXW1. 
2 Port Config Shows information on devices connected to the ports of the EX600-L#B1 or EX245-L#1. 
3 Settings Shows parameter setting information for the EX600-L#B1. 

 
Note: EX600-SEC3/SEC4, EX600-MEN1, EX600-MEC1, EX600-BEN1, EX600-BPN1, EX600-BEC1, 
EX245-SPN#A, EXW1-BECAC, EXW1-BPNAC1, EXW1-BENAC1 and EXW1-BMTAC don’t support the 
Settings tab. 
 
 

8.3. Common Screen 
 - The Common Screen of the SMC-EX600/EX245/EXW1 shows property data such as the Vendor ID. 
  (The image is an example of EX600.) 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

№ Item Outline 
1 Vendor SMC Corporation, fixed value 
2 IO-Link Vendor ID 0x0083, fixed value 
3 Product name The SI unit, FB module or compact wireless base name, fixed value 
4 IOLM Shows the name of the IOLM file being used. 
5 IP Address Shows the IP address of the SI unit, FB module or compact wireless base being monitored. 
6 MAC Address Shows the MAC address of the SI unit, FB module or compact wireless base being monitored. 

 
  

(1) 
(2) 

(3) 

(4) 

(5) (6) 
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8.4. Port Config Screen 
  8.4.1. Reading the IO-Link Port Settings 

 - The following shows how to read the port settings of the EX600-L#B1, EX245-L#1 or EXW1-RL#. 
 
(1) Set the status to [Go Online]. 
(2) Press [read from master] to read the port settings of the EX600-L#B1, EX245-L#1 or EXW1-RL#. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: In the case of EX245, show from the IO-Link Module connected to the position nearest to the SI 

unit. 
      In the case of EXW1, show from wireless channele 1.  

(1) 

(2) 

Shows the port mode settings of Ports 1 to 4 of the IO-Link 
Module connected to the position nearest to the end plate 
(Port 1, 2, 3, and 4 from the top). 

Shows the port mode settings of Ports 1 to 4 of the IO-Link 
Module connected to the position second from the end plate 
(Port 1, 2, 3, and 4 from the top). 

：Offline ：Online 

* When the port setting IOL_Manual and Validation & Backup is 
set as shown below, the set Vendor ID and the device with the 
Device ID are shown. 

- Type compatible Device V1.1 
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   8.4.2. Changing the Settings of the IO-Link Ports (Only possible when not connected to PLC) 

 - The following shows how to change the port settings of the EX600-L#B1 by using IO-Link Device Tool. 
* EXW1 series cannot change IO-Link ports by the IO-Link Device Tool. 

 
(1) Set the status to [Go Offline]. 
(2) Place the cursor on [Mode] of the Port whose setting you want to change and right-click the mouse.  

The settings for the port will be shown. 
(3) Place the cursor on the desired Port settingand left-click the mouse. [Mode] will be set to that setting. 
(4) When you press [Go Online], the "Synchronize Port Configuration" screen will appear. 
(5) Press [write to master] to apply the setting to the EX600-L#B1. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
* When the SI unit, FB module or compact wireless base is EX600-SPN3/4/31, EX600-MPN1, EX600-BPN1, 

EX245-SPN#A, EXW1-BECAC, EXW1-BPNAC1, EXW1-BENAC1 or EXW1-BMTAC use the configuration 
software of the PLC or IO Configurator (only EXW1) to change the parameters of EX600-L#B1, EX245-L#1 
and EXW1-RL#. 

 
* Parameters cannot be changed by the IO-Link Device Tool while communication with the PLC is 

established.  
  

(1)(4) 

(2) (3) 

(5) 
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 8.4.3. Scanning IO-Link Devices 

 - The following shows the procedures for scanning IO-Link devices when communication with IO-Link 
devices connected to the EX600-L#B1, EX245-L#1 or EXW1-RL# is established. 

 
(1) Set the status to [Go Online]. 
(2) Press [Check Devices]. The connected IO-Link devices will be shown. 
(3) Press [Takeover devices into engineering]. 
(4) Models, etc. of the connected IO-Link devices are shown. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

(1) (2) 

(3) 

(4) 



-19- 

 
No.EX##-OMY0032-G 

 
 
  8.4.4. IO-Link Device Validation Function / Data Storage Function Setting 

(Only possible when not connected to PLC) 
 - In the "Port Config Details" on the Port Config Screen of the SMC-EX600, the settings for the IO-Link 

device Validation Function / Data storage function can be set for each port. 
* EXW1 series cannot change IO-Link Device Validation Function / Data Storage Function Setting by 
the IO-Link Device Tool. 

 
(1) Set the status to [Go Offline]. 
(2) Select a port whose [Mode] is set to IO-Link. 
(3) Select the validation & Backup setting in [IO-Link Mode]. 

* For details on each setting, refer to the SI unit, FB module or compact wireless base Operation  
Manual of protocol used. 

(4) When the status is set to [Go Online], the Synchronize Port Configuration screen appears.  
Press the [write to master] button, to apply the setting to the EX600-L#B1. 

* See page 17 for the screen. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
* When the SI unit, FB module or compact wireless base is EX600-SPN3/4/31, EX600-MPN1, EX600-BPN1, 

EX245-SPN#A, EXW1-BECAC, EXW1-BPNAC1, EXW1-BENAC1 or EXW1-BMTAC use the configuration 
software of the PLC or IO Configurator (only EXW1) to change the parameters of EX600-L#B1, EX245-L#1 
and EXW1-RL#. 

 
* Parameters cannot be changed by the IO-Link Device Tool while communication with the PLC is 

established. 
 
 
 
  

(1) 

(2) 

(3) 
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  8.4.5. Port Config Details 

 - In "Port Config Details" on the Port Config screen of the SMC-EX600/EX245/EXW1, information on 
connected IO-Link devices is shown. 

 
(1) Select a port to which an IO-Link device is connected. 
(2) The information on the IO-Link device is shown in "Port Config Details" as shown below. 

 
№ Item Outline 
1 Vendor ID Vendor ID 
2 Device ID Device ID 
3 Product ID Product ID 
4 IODD IODD file name 
5 Device PD Length Inputs Input size of the process data 
6 Device PD Length Outputs Output size of the process data 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

(1) 

(2) 
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8.5. Settings Screen 

- The Setting Screen shows parameter setting information for the EX600-L#B1. 
 
* EX600-SEC3/SEC4, EX600-MEN1, EX600-MEC1, EX600-BEN1, EX600-BPN1, EX600-BEC1, EX245-
SPN#A, EXW1-BECAC, EXW1-BPNAC1, EXW1-BENAC1 and EXW1-BMTAC don’t support the Setting 
screen. 

 
  8.5.1. Reading IO-Link Module Parameters 

- The following shows the procedure to read the parameters of the EX600-L#B1. 
- For details of the parameters, refer to the SI unit, FB module or compact wireless base Operation Manual 
of protocol used. 
 
(1) Set the status to [Go Online]. 
(2) Select the [Settings] tab. The parameters of the module selected in "List of Masters" will be shown. 
(3) The modules can be switched in “List of Masters” area. 
(4) "Maximum" of "Total Input/Output Size" shows the maximum acceptable configuration size that can be 

occupied, and "Configured" shows the actually occupied configuration size (for the EX600-
SEN7/SEN8 and EX600-SEN3-X80 only). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. Screen for the EX600-SPN3/4 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. Screen for the EX600-SEN7/SEN8, and EX600-SEN3-X80 

(1) 

(3) 

(2) 

 

 

 

 
(1) 

(3) 

(2) 

(4) 
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  8.5.2. Setting the IO-Link Module Parameters (Only possible when not connected to PLC) 

(for the EX600-SEN7/SEN8, and EX600-SEN3-X80 only) 
- The following shows the procedure to set the parameters of the EX600-L#B1. 
- For details of the parameters, refer to the SI unit, FB module or compact wireless base Operation Manual 

of protocol used. 
 
(1) Set the status to [Go Offline]. 
(2) Select the [Settings] tab. The parameters of the module selected in "List of Masters" will be shown. 
(3) The modules can be switched in “List of Masters” area. 
(4) When the status is set to [Go Online] after changing the " Module Parameter," the "Synchronize Port 

Configuration" screen appears. 
(5) Press [write to master] to apply the parameters to the module. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
* When the SI unit, FB module or compact wireless base is EX600-SPN3/4/31, EX600-MPN1, EX600-BPN1, 

EX245-SPN#A, EXW1-BECAC, EXW1-BPNAC1, EXW1-BENAC1 or EXW1-BMTAC use the configuration 
software of the PLC or IO Configurator (only EXW1) to change the parameters of EX600-L#B1, EX245-L#1 
and EXW1-RL#. 

* Parameters cannot be changed by the IO-Link Device Tool while communication with the PLC is 
established.  

(1) 

(5) 

(2) 

(3) 

(4) 
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8.6. Setting the IO-Link Devices 
  8.6.1. Reading Information on IO-Link Devices 

- Reading information on an IO-Link device can be performed using the following procedure. 
- The following screens are examples of using a pressure switche ISE20B-L. The dedicated IODD file has 

been imported in advance. 
* Screens differ depending on the IO-Link device. 

 
(1) Select an IO-Link device to read information, after setting the status to [Go Online], and double-click the 

row. 
(2) The Common tab screen for IO-Link devices appears in a new window. 
(3) Pressing the [Upload from device] button, the information on the connected IO-Link device will be read. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

(1) 

(3) (2) 
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  8.6.2. IO-Link Device Process Data (Example using the ISE20B-L) 

- When the "Process Data" tab of the ISE20B-L is selected, the following screen appears. 
- Displays Pressure information, diagnostic information, and switch output status, which comprise the input 

2 Byte process data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 8.6.3. IO-Link Device Identification (Example using the ISE20B-L) 

- When the "Identification" tab of the ISE20B-L is selected, the following screen appears. 
The specific IO-Link device data can be viewed in the “Identification” tab. 

- Only the "Application-Specific Tag" allows writing. 
 

(1) Pressing the [Upload from device] button, the information on the connected device will be read. 
(2) Select either the "block write mode" or "direct write mode" for the device writing mode. 

 * For details of the difference between the writing modes, see the User Manual prepared by TMG. 
(3) Any value within 32 characters can be set for the value of "Application-Specific Tag." 

 To change this value, press the [Enter] button after directly entering the characters. 
(4) Press the [Download to device] button to write this change to the IO-Link device. 

 
 
 
 
 
 
 
 
 
 
 
 
 
  

(1) 

(3) 

(4) (2) 
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  8.6.4. IO-Link Device Observation (Example using the ISE20B-L) 

- When the Observation tab of the ISE20B-L is selected, the following screen appears. 
- Pressure information, diagnostic information, and switch output status are shown. 

 
(1) Pressing the [Upload from device] button, the information on the connected device will be read. 

 
 
 
 
 
 
 
 
 
 
 
  

(1) 
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  8.6.5. IO-Link Device Parameter (Example using the ISE20B-L) 

- When the Parameter tab of the ISE20B-L is selected, the following screen appears. 
The set parameters can be checked. 

- For details of the parameters, refer to the Operation Manual of the using IO-Link device. 
 

(1) Pressing the [Upload from device] button, the information on the connected device will be read. 
(2) Select either the "block write mode" or "direct write mode" for the device writing mode. 
  * For details of the difference between the writing modes, refer to the User Manual prepared by TMG. 
(3) Change "Value." ("State" will change to "c.") 
(4) Press the [Download to device] button to write this change to the IO-Link device. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

(1) 
(3) 

(4) (2) 
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  8.6.6. IO-Link Device Diagnosis (Example using the ISE20B-L) 

- When the Diagnosis tab of the ISE20B-L is selected, the following screen appears. 
- For details of the Diagnosis data, refer to the Operation Manual of the relevant IO-Link device. 

 
(1) Pressing the [Upload from device] button, the information on the connected device will be read. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  8.6.7. IO-Link Device Scope (Example using the ISE20B-L) 

- When the Scope tab of the ISE20B-L is selected, the Scope screen appears. In th Scope screen, process 
data can be displayed in charts. 

- For details on the Scope function, refer to the User Manual prepared by TMG. 
 

 
 
 
  

(1) 
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  8.6.8. IO-Link Device Generic (Example using the ISE20B-L) 

- When the Generic tab of the ISE20B-L is selected, the following screen appears. 
- For details of the Generic data, refer to the Operation Manual of the using IO-Link device. 

 
(1) When the [Upload from device] button is pressed, the information on the connected device will be 

read. 
(2) The information on Direct Parameter Page 1 is shown. 
(3) The current value of input/output Process Data is displayed. 

If the PLC is not connected, output Process Data can be written. 
(EX600-SEN3-X80 does not support writing output Process Data.) 

(4) Parameters of IO-Link devices are able to Read/Write by specifying ISDU (indexed service data unit). 
(5) Message Box records the appearence and disappearance log of event information. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

(1) 

(3) 

(2) 

(4) 

(5) 
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  8.6.9. IO-Link Device IODD (Example using the ISE20B-L) 

- When the IODD tab of the ISE20B-L is selected, the following screen appears. 
- Detailed information on the IODD file is shown. 
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